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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between the service provider Alestra in Mexico and Avaya IP Office 7.0(5).
The official name of Alestra’s SIP Trunk offering is “Enlace IP”.

Alestra’s Enlace IP SIP Trunk Service provides PSTN access via SIP trunks between the
enterprise and Alestra’s network as an alternative to legacy analog or digital trunks. This
approach generally results in lower cost for the enterprise.

Service provider Alestra in Mexico is a member of the Avaya DevConnect Service Provider
program. Information in these Application Notes has been obtained through DevConnect
compliance testing and additional technical discussions. Testing was conducted via the
DevConnect Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe a sample configuration using Session Initiation Protocol (SIP)
Trunking between the service provider Alestra in Mexico and an Avaya IP Office solution.

In the sample configuration, the Avaya IP Office solution consists of an Avaya IP Office 500v2 -
Release 7.0(5) with a Digital Expansion Module - Release 9.0(5), Avaya Voicemail Pro, Avaya
IP Office Softphone (SIP), Avaya IP Office Phone Manager PC Softphone (H.323), Avaya IP
Telephones (H.323), Avaya Digital Telephones, Analog Telephones and Fax machines.

Customers using Avaya [P Office with Alestra’s Enlace IP SIP Trunk service are able to place
and receive PSTN calls via the SIP protocol. The converged network solution is an alternative to
traditional analog trunks and/or PSTN trunks such as ISDN-PRI. This approach generally results
in lower cost for the enterprise.

2. General Test Approach and Test Results

The general test approach was to simulate an enterprise site in the Solution & Interoperability
Test Lab by connecting an Avaya IP Office Release 7.0(5) to Alestra’s Enlace IP SIP Trunk
service via the public internet, as depicted in Figure 1.

2.1 Interoperability Compliance Testing
To verify SIP trunk interoperability, the following areas were tested for compliance:

e Static IP Authentication.

e SIP OPTIONS messages.

e Incoming calls to IP Office from the PSTN were routed to the DID numbers assigned by
Alestra. Incoming PSTN calls were terminated to the following end points: Avaya IP
Telephones (H.323), Avaya Digital Telephones, IP Office Softphone (SIP), IP Office
Phone Manager PC Softphone (H.323), Analog Telephones and Fax machines.

e Outgoing calls from IP Office were routed via Alestra’s GSX9000 Sonus network to the
various PSTN destinations. A local PSTN extension in Monterrey & telephones in the
Test Lab connected to the PSTN in the U.S. were used as PSTN end points.

e Proper disconnect when the caller or the callee abandoned the call before the call was
answered.

e Proper disconnect with normal active call termination by the caller or the callee.

e Proper disconnect by the network for calls that were not answered (with voice mail off).

e Proper response to busy end points.

e Proper response/error treatment when dialing invalid PSTN numbers.

e Proper Codec negotiation and two way speech-path. G.729(a) codec and G.711-Alaw
codec were tested as requested by Alestra (common codec’s used in Mexico).

e Proper response/error treatment with no matching codec’s between the network and the
enterprise.

e Voice mail and DTMF tone support.

¢ Outbound Toll-Free calls, interacting with IVR (Interactive Voice Response) systems.
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Outbound/Inbound local calls.

International calls.

Calls to special numbers (Alestra information: 040, etc.).
Calling number blocking from IP Office and from PSTN.
Call Hold/Resume (long and short duration).

Call Forward (unconditional, busy, no answer).

Blind Call Transfers.

Consultative Call Transfers.

Station Conference.

T.38 Faxing support (inbound and outbound).

IP Office Mobility Twinning.

Avaya IP Office Softphone (SIP).

Avaya [P Office Phone Manager PC Softphone (H.323)
Simultaneous active calls.

Long duration calls (> one hour).

Proper response/error treatment to all trunks busy.
Proper response/error treatment when disabling SIP connection.

2.2 Test Results

Interoperability testing of Alestra’s Enlace IP SIP trunk service with Avaya IP Office was
completed successfully with the following observations/limitations.

1.

Feature Name Extension (FNE) — This is a Mobility Twinning feature for Mobile call
control. This feature provides dial tone to twinned mobile devices (e.g. cell phone)
directly from IP office; once dial tone is received the user can perform dialing actions
including making calls and activating Short Codes.

To get the FNE feature to work with the dial plan specific to Mexico the following
settings had to be matched. Note: The user gets a Busy tone (486 Busy Here) when
attempting to activate the feature if settings are not matched.

Example Configuration:
Using DID number 8128813093 from local PSTN as the twinned mobile extension.
Using extension number 3041 in IP Office as the Host station.

INVITE received by IP Office:

The “FROM?” field in the invite sent by the Twinned mobile extension to IP Office when
dialing the number of the Host station is in the following format:
From:<sip:8128813093 @ xxx.xxx.xxx.9

IP Office settings:
User/3041/Mobility: Twinned Mobile Number = 8128813093
Incoming Call Route/Incoming CLI = 8128813093
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With the above settings calling party receives dial tone from IP Office for dialing. but
twinning doesn’t work since the number is not in the correct format. For twinning to
work the following setting is needed:

User/3041/Mobility: Twinned Mobile Number = 28813093
This issue may be resolved by digit manipulation in Alestra’s network.

2. Outgoing Call Transfers from IP Office to the PSTN will not complete if Short Code 9N;
or ARS 9N are used. The problem is in the REFER message from IP Office to the Service
Provider’s network (Sonus). If Short Code 9N; or ARS 9N are used, IP Office will inserts
the leading digit “9” to the number in the “Refer-to” header (in Refer message), for
example: 928813093 @xxx.xxx.xxx.9 thus causing Sonus to generate a “503 Service
Unavailable” response in the Notify message. With Alestra’s Enlace IP SIP Trunk
service, Sonus is not programmed to route calls with the leading digit “9”.

The work around is to add Short Code 2N; in IP Office to send the digits in the Refer-to
header in the following format: 28813093 @xxx.xxx.xxx.9 (without the leading “9”).

Note: Short Codes and ARS are two important features of [P Office, Short Code 9N; will
allow users to dial any number after the “9” and ARS provides second dial tone, alternate
routing, etc.

3. Incoming Attended Call transfers from the local Mexican PSTN to IP Office and back to
the local Mexican PSTN will not complete. The problem is in the REFER message from
IP Office to the Service Provider’s network (Sonus). IP Office inserts “81” to the number
in the “Refer-to” header (in Refer message), for example: 8128813093 @ xxx.xxx.xxx.9
thus causing Sonus to generate a “503 Service Unavailable” response in the Notify
message. With Alestra’s Enlace IP SIP Trunk service, Sonus was not programmed to
route calls with leading digits “81”.

The work around is to add routing based on leading digits “81” to Alestra’s network
(Sonus).

Note: 81 is the area code for Monterrey, Mexico, the country code for Mexico (not
shown here) is 52.

4. Outgoing Fax calls fail to connect. The problem is seen with outgoing Fax calls (IPO =
PSTN) with T.38 Interworking with G.711-Alaw. Traces captured indicate successful
conversion from G.711-Alaw to T.38 but the “modem connection” fails to be established
and the attempt times out. At the user level, both fax machines show “connecting”, the
tone is heard and the attempt is made to scan the 1 page but failure happens eventually
due to connection time-out.

The work around is to use G.729(a) interworking with T.38
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5. Testing was executed using G.729(a) and G.711-Alaw codec’s as requested by Alestra
(common codec’s used in Mexico).

6. Call Display on transferred calls to PSTN — Caller ID display is not properly updated on
PSTN phones involved with call transfers from IP Office to the PSTN. On Call Transfers
from IP Office to the PSTN, after the call transfer is completed, the PSTN phone does not
display the actual connected party but instead shows the ID of the host extension that
initiated the call transfer.

7. Calls originating from PSTN telephones in the U.S. to Mexico DIDs assigned to IP
Office will display “Restricted/Unavailable”. This is a PSTN restriction for all calls from
the U.S. to Mexico. For testing Alestra provided a local PSTN number in Monterrey,
Mexico. A SIP Softphone was registered to this local PSTN number and was used to
originate and terminate calls to and from the Mexican PSTN to IP Office. Alestra also
provided access to a WEB based GUI allowing feature changes to this local PSTN
number.

Note: International long distance call will be presented without Caller ID in accordance
with International Rule between carriers.

8. TItems not supported or not tested included the following:
e Inbound toll-free calls.
e 0,0+10,411,911, etc. are call types not supported in Mexico. Instead, calls to special
numbers in Mexico were tested (e.g. information: 040, Denuncia: 089, etc.).

2.3 Support

2.3.1. Avaya

For technical support on the Avaya products described in these Application Notes visit
http://support.avaya.com.

2.3.2. Alestra

For technical support on Alestra Enlace IP SIP Trunk service offer visit the online support site at
http://www.alestra.com.mx/negocios.asp?id=206

3. Reference Configuration

Figure 1 below illustrates the test configuration used. The test configuration simulates an
enterprise site connected to Alestra’s Enlace IP SIP trunk service through the public internet.

Located at the enterprise site is an Avaya [P Office 500v2 with a Digital expansion module. The
LAN port of the Avaya IP Office is connected to the enterprise LAN while the WAN port is
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connected to the public internet via a T1 to the local service provider. The T1 coming in to the
simulated enterprise site from the local service provider is connected to an Adtran 604 router.

Actual customer configuration may also include additional network components between the service

provider’s network and the Avaya IP Office, such as a session border controller at the Service
provider and firewalls at the enterprise site.

Service Provider

~
Alestra Domain:

asbw.alestravoip.com

Enlace IP SIP
Trunk Service
(SONUS Platform)

L IP: XXX XXX.XXX.9 (Signal) IP: XXX XXX XXX.7 (Media)/

Interne

Enterprise
2 'Adtran 604 Router

WAN: XX XXX.XXX.128/26

LAN: XXX.XX.X.0/24

IP Office Softphone Avava 962
IP Office Phone Manager PC Softphone P -:-I:l?p:gngs Avaya 9620
Digital Telephones Voice Mail Pro (H.323) IP Telephones
IP Office Manager (H.323)
Analog Telephones s ’
Avaya 9508
Digital Telephones
\_ J

Figure 1: Test Configuration for Avaya IP Office with Alestra Enlace IP SIP Trunk Service
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The following DIDs (for Monterrey, Mexico), US PSTN numbers, and end point types were used
for testing:

DID Number Client Type Notes
(81) 1234-3040 Avaya 9620 IP Registered with IP Office.
Telephone (H323)
(81) 1234-3041 Avaya 9620 IP Registered with IP Office.
Telephone (H323)
(81) 1234-3042 Avaya 9620 [P Registered with IP Office.
Telephone (H323)
(81) 1234-3043 Avaya 9508 Digital Registered with IP Office.
Telephone
(81) 1234-3044 Avaya 9508 Digital Registered with IP Office.
Telephone
(81) 1234-3045 Not Used -
(81) 1234-3046 Not Used -
(81) 1234-3047 Avaya IP Office Registered with IP Office.
Softphone (SIP)
(81) 1234-3048 Avaya IP Office Phone Registered with IP Office.
Manager PC Softphone
(H.323)
(81) 1234-3049 Not Used ---
(81) 1234-3093 SIP Softphone Registered with the local PSTN in Monterrey,
Mexico
US PSTN Number Client Type Notes
1-555-123-0788 Avaya 9641G IP Registered with the local PSTN in the U.S.
Telephone
1-555-123-0772 Analog Line/Phone Connected to the Local PSTN in the U.S.

Table 1 — DID / US PSTN Numbers and IP Office Client Types Used for Testing
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4. Equipment and Software Validated

The following equipment and software were used for the sample configuration provided:

Component \ Version
Avaya

Avaya IP Office 500v2 7.0 (5)
Avaya IP Office Digital Expansion Module 9.0 (5)
Avaya [P Office Manager 9.0 (5
Avaya Voicemail Pro Client 7.0 (17)

Avaya 9620 Series I[P Phones (H.323)

Avaya one-X Desk phone Edition 3.1

Avayal408 Series Digital Phone

Avaya 9508 Series Digital Phone

Lucent Analog Phone

Avaya IP Office Softphone (SIP)

Avaya IP Office Phone Manager PC Softphone
(H.323)

Fax Machines

SIP based Softphone (For use at local PSTN in
Monterrey, Mexico)

Alestra

Sonus Network

6.4

Table 2 — Hardware and Software Components Tested
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5. Configure IP Office

IP Office is configured via the IP Office Manager program. For more information on IP Office
Manager, consult reference [2]. From the IP Office Manager PC, select Start > Programs >

IP Office > Manager to launch the Manager application. A screen that includes the following
in the center may be displayed:

WELCOME to IP Office Administration

What would you like to do ?

Create an Offline Confiquration

Dipen Configuration from System

Fead a Configuration from File

Navigate to File > Open Configuration, select the proper Avaya IP Office system from the
pop-up window, and log in with the appropriate credentials.

A management window will appear similar to the one shown in the next section. The appearance
of the IP Office Manager can be customized using the View menu. In the screens presented in
this section, the View menu was configured to show the Navigation pane on the left side and the
Details pane on the right side. These panes will be referenced throughout the Avaya IP Office
configuration. Proper licensing as well as standard feature configurations that are not directly
related to the interface with the service provider (such as LAN1 interface to the enterprise site
and IP Office Softphone support) is assumed to be already in place.
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5.1 LAN2 Settings

In the sample configuration, the MAC address 00E00706530F was used as the system name and
the WAN port was used to connect the Avaya IP Office to the public network. The LAN2
settings correspond to the WAN port on the Avaya IP Office. To access the LAN2 settings, first
navigate to 00E00706530F - System (1) in the Navigation Pane and then navigate to the LAN2
Settings tab in the Details Pane. Set the IP Address field to the IP address assigned to the Avaya
IP Office WAN port, this is a public address. Set the IP Mask field to the mask used on the
public network. All other parameters should be set according to customer requirements.

File — Edit  Wiew Tools Help

i DOEOO7OES30F = System ~ OOECO7OBS30F aid=E-HIE J ANl 528
"
IP Offices B D0EQ0706530 gf - X | v|<|
R eootP(z) System | LANL |L»‘1|'\|2 |DNS Vaicemail | Telephorry || Directory Services | System Events | SMTP || SMOR | Twinning | vCM | CCR
{7 Operator (3) -
=)-#59 ODEDO7O6530F LAN Settings |yolP | Metwork Topology

3 System (1)

- 12 34 a7 190

£ Line {3) 1P Address
= Control Unit (4) 1P Mask 255 . 255 255 . 192
Ay Extension {35)
a User {32} Primary Trans. IP Address 0 a 1} o
ﬁ HurkaEroup {13 . y
B3¢ Short Code (60) Firewall Profile ‘<N0ne> v‘

@ Service (1) RIP Made ‘None v ‘
l RAS (1)
e Incoming Call Routs {2) [ Enable MaT

@ WanPort (0)

1 -
am Dirsctory (0) Mumber OF DHCP 1P Addresses
£ Time Profile (09 DHCP Mode

# Firewsall Profile {1 N . ;
I::‘:ite E:)Ie( ) () Server O Clisnt O pialin (%) Disabled

i Account Code {0)
W Licence (76)
& Tunnel {0)
a; User Rights (&)
Y ARS (1)
" RAS Location Request {0)
fi= E911 System (1)

[ ok J[ cond J[ Heb
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Select the VoIP tab as shown in the following screen. The SIP Trunks Enable box must be
checked to enable the configuration of SIP trunks to Alestra’s Enlace IP SIP Trunk service. The
RTP Port Number Range can be customized to a specific range of receive ports for the RTP
media. Based on this setting, Avaya IP Office would request RTP media be sent to a UDP port in
the configurable range for calls using LAN2. Avaya IP Office can also be configured to mark the
Differentiated Services Code Point (DSCP) in the IP Header with specific values to support
Quality of Services policies for both signaling and media. The DSCP field is the value used for
media and the SIG DSCP is the value used for signaling. The specific values used for the
compliance test are shown in the example below. All other parameters should be set according to

customer requirements.

File Edit VWiew Tools Help

i DOEOO706S30F T System

IP Offices

K eooTr(2)
{7 Operator (3)
[=-5=p DOEOOFOES30F

v Cankral Unik {4)
4 Extension (35)
a User {32)
u HunkGroup {13
@ Short Code (60}
@ Service (0}
o RAS (1)
e Incoming Call Route {2)
Eﬂ “WanPort {0}
i Directory (0)
f:.“\ Time Profile {0}
@ Firewall Profile (1)
Bl 1P Route (4)
i Account Code {0}
W Licence (76)
& Tunnel {0)
a 3 User Rights (3)
Y BRS (1)
" RAS Location Request (0)
fix E911 System (1)

12 5-dIFRE Al 227
00EQ0706530F

~ (0DEQO708S30F o
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LAMN Settings | WoIP | Network Topology
[] H323 Gatekeeper Enable
SIP Trunks Enable
[] siF Registrar Enable
RTF Port Mumber Range
H323 Auto-creake Extn Port Rangs (Miimum)
[ H323 Auto-create User Park R.ange (Maximurm)
SnnagloertRs'l'DCDPSMonltonng
DiffSery Setkings
DSCR(Hex) DSCF Mask (Hex) 51 DSCP (Hex)
DsCP DSCP Mask 34 % | slzDscp
DHCP Settings
Primary Site: Spedfic Option Mumber {SSON) 176 k|
Secondary Site Specific Option Mumber (SSOM) 242 £
1100 Yaice YLAN Site Specfic Option Number (S50N)
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Select the Network Topology tab as shown in the following screen, configure the following
parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in
the compliance test as shown in Figure 1, so the parameter was set to Open Internet.
With this configuration, STUN will not be used.

¢ Set Binding Refresh Time (seconds) to 300. This value is used as one input to
determine the frequency at which Avaya IP Office will send SIP OPTIONS messages
to the service provider. Refer to section 5.10 for additional parameters that need to be
set for SIP OPTIONS.

e Set Public IP Address to the IP address of the Avaya IP Office WAN port.
e All other parameters should be set according to customer requirements.

File  Edit Wiew Tools Help

O0EQO70&S30F T System T O0EOO7O0&S30F T

IP Offices

R BOOTP (2}
7 Operator (3)

Syshem | LAML ||--‘W2 |DNS Yoicemail | Telephory | Directary Services | Syskem Events | SMTP | SMDR | Twinning | YCM

=)+ DOEO0706530F LAM Settings | ¥oIP | Metwark Topology |
552 System (1) Mebwork Topology Discovery

% D0EO0706S30F ~
7 Line (3) STUN Server IP Address | 69 . 90 . 166 . 13 | STUMPort (3478 3

<2 Control Unit (4)
Ay Extension (35) o )
§ User(a) (85"::23 d':f”es'“ Time — [3np
ﬂ- HuntGroup (1)

CCR
8% Short Code (63) Public IP Address [12 . 3¢ &7 . 190 |
Service (0
E R::E:;( ) Public Port S0s0 % -_Run STUN el

FirewallfNAT Type |Open Inkernet £ |

-
-

@ Incoming Call Route (2)
Eﬁl ‘WanPork {0} [ Run STUN en startup
@ Direckary (0)
£ Time Prafile (03

@- Firewall Profile {1}

BB IF Route (4)

@ Account Code (0)

S Licence (76)

@& Tunnel {0}

a; User Rights {8}

¢ ARS (1)

" RAS Location Request {0}

fx E911 System (1)
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5.2 System Telephony Settings

Navigate to the 00E00706530F - System (1) = Telephony Tab in the Details Pane. Set the
Automatic Codec Preference for the default codec to be used for intra-enterprise traffic. This
setting is used by all IP lines and extensions where the Compression Mode has been set to
Automatic Select. The codec selected here will be the first codec the line or extension uses for
codec negotiation. Companding LAW settings should not normally be changed from their
defaults. They should only be used where 4400 Series phones (U-Law) are installed on systems
which have A-Law digital trunks. Note that U-Law is also called Mu-Law or p-Law. Uncheck
the Inhibit Off-Switch Forward/Transfer box to allow call forwarding and call transfer to the
PSTN via the service provider across the SIP trunk.

File  Edit  View Tools  Help

O0EOO7OBS30F T System - D0EQ07O6S30F =

IP Offices

R BOOTP(2)
i Operator (3)
(=27 DDEDDFOES30F Telephory |Tones&Music CallLog
[=-#=p System (1)
) D0EQO7O6530F

T i Switch Line
T4 Line (3) . Default Outside Call Sequence Marmal “
<2 Contral Unit (43 .
<Ay Extension (35} Default Inside Call Sequence Ring Type 1 w @ uuaw @ UL Line

ﬂ User (32)

u Hunk&roup (13 Default Ring Back Sequence Ring Type 2 b4

125 W ERE A 228
B 00E00706530F EREIR

System || LANL | LAMZ | DNS VoicemaiI|TE|EDh0nY |Direct0ryServices Syskem Events || SMTP | SMDR | Twinning | VCM CCR

Analogue Extensions Campanding Law

O aLaw O aLAw Line

9 short Cods (53) Restrict Analogue Extension Ringer Yolkage [

@ Service (0)
o RAS (?) Dial Delay Time (secs) [ pss status
@ Incoming Call Route (2)

48 wanport (0) Dial Delay Count Auta Hold

am Directory (0} Bl = = |

TN i Default Mo Answer Time (secs - Dial By Marne
£ Time Profile (0) {secs) Y

@ Firewall Profile (1)

Hald Timeout (secs) LR Show Account Cade
@l 1P Route (4)
#m Account Code (0) Park Timeout {secs) 300 5 [ 1nhibit OFF-Switch ForwardTransfer
W Licence (78] .
i Tunnel (0) Ring Delay {secs) [ Restrick Mebwork Interconnect

a 3 User Rights (3)
¢ ARS (1)
# RAS Location Request (0) Default Currency sD o [ wisually Differentiate External Call

fx E911 System (1)
Automatic Codec Preference G.729(a) 8K CS-ACELP W

Call Priotity Promation Time {secs)  [Disabled E [ brap External Only Impramptu Conference
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5.3 Twinning Settings

To view or change Twinning settings, select the Twinning tab as shown in the following screen. The
Send original calling party information for Mobile Twinning box is not checked in the sample
configuration, and the Calling party information for Mobile Twinning is left blank. With this
configuration, and related configuration of Remote Party ID on the SIP Line (Section 5.4), the true
identity of a PSTN caller can be presented to the twinning destination (e.g., a user’s mobile phone).

File  Edit wiew Tools Help
i DOEOOFORSI0F * System ~ (0EO070ES30F a2 E-EH = ,j Al 528

IP Offices i= 00E00706530

K eooTR(2)

System | L&M1 || LaNZ2 | DNS | Yoicemall | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning |VCM CCR
% Operator (3}

[=)-#%p O0EQOFOES30F [[] send original calling party information For Mahile Twinring
==y System (1) Calling party information For
3y O0EOO70ES30F Mobile Twinning

T4 Line (3)
< Control Urit {4)
A Extension [34)
ﬂ User (323
%8 HureGroup (1)
@3 short Code (60)
@ Service (0)
Al RAS (1)
@ Incoming Call Route (2)

@ “WanPart (0

am Directory (0)

f:.“ Time Profile {0)
@ Firewall Profile (1)
@ 1P Route (4)

i Account Code (0)
W Licence (76}

& Tunnel {0)

§ User Rights (5)
Y ARS (1)

" RAS Location Request (0)

fix E911 System (1)
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5.4 SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and Alestra’s
Enlace IP SIP Trunk service. To create a SIP line, begin by navigating to Line in the left
Navigation Pane, then right-click and select New =  SIP Line, IP Office automatically assign
a Line Number. On the SIP Line tab in the Details Pane, configure the parameters as follows:

e Set ITSP Domain Name to the SIP Proxy IP Address of the service provider
(Alestra), this IP Address is xxx.xxx.xxx.9 (Signaling IP address), the same IP
address used in the Transport tab. IP Office uses this field on the host portion of SIP
URI in SIP headers such as the “From” header.

e Set Send Caller ID to Remote Party ID. [P Office will include the Remote Party ID
for calls that are directed via Mobile Twinning out the SIP Line to Alestra’s network.
Remote Party ID will contain the number associated with the party originating the
call and will be populated with the true calling party identity, allowing the twinning
destination (e.g., mobile phone) to see the true caller id.

e Check the In Service box.

e Check the Check OOS box. With this option selected, IP Office will use the SIP
OPTIONS method to periodically check the SIP Line.

e Set Call Routing Method to To Header

e Default values may be used for all other parameters.

The Association Method parameter was introduced in IP Office Release 7.0, and the screen
below shows the default value, which is sufficient in the sample configuration.

The area of the screen entitled REFER Support is used to enable/disable SIP REFER for call
transfers. The default values of “Auto” for Incoming and Outgoing effectively disable use of
SIP REFER. To enable SIP REFER, select “Always” from the drop-down menu for Incoming
and Outgoing. In the compliance test this feature was enabled to test transfers of call between a
PSTN phone and an enterprise phone to a second PSTN phone.

By default, the In Service and Check OOS boxes are checked. In the sample configuration, IP
Office will use the SIP OPTIONS method to periodically check the SIP Line. The time between
SIP OPTIONS sent by IP Office will use the Binding Refresh Time for LAN2, as shown in
Section 5.1 LAN2 Settings in the Network Topology tab. See Section 5.10 for additional
information related to configuring the periodicity of SIP OPTIONS.
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i Avaya IP Office R7 Manager Q0EQ0706530F [7.0(5)] [Administrator{Administrator)]

File  Edit Wiew Tools Help

OO0EQO70&530F -] Line
IP Offices

K BOOTR (2)
{7 Operator (3)

E =y D0EOO706530F

[ Control Unit {4)
[+ 4y Extension {35)
-§  User (32)
E
E
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£ @% Short Code (63)

----- s Service {0}

-l RAS (1)

E]---@ Incoming Call Route (2)
----- @ ‘WanPort {00

- Directory (0}

Time Profile {0}

Firewall Profile (1)

IP Route (4)

Account Code (00

W Licence (76)

----- i Tunnel {0)

E]---h User Rights (3}

" BRI (1)

----- " RAS Location Request (0}
[-fx E911 System (1)
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SIP Line -Line 17*
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ITSP Domain Marme |xxx.xxx.xxx.9 | In Service
Use Tel URI B

Preafix | | checkoos
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Select the Transport tab. The ITSP Proxy Address is set to the service provider SIP Proxy IP
Address (provided by Alestra). As shown in Figure 1, this [P Address is xxx.xxx.xxx.9
(Signaling IP address). In the Network Configuration area, UDP is selected as the Layer 4
Protocol, and the Send Port is set to the port number provided by Alestra (5060). The Use
Network Topology Info parameter is set to LAN 2. This associates the SIP Line with the
parameters in the System - LAN2 - Network Topology tab. Other parameters may retain
default values as in the screen below.

'_' Avaya IP Office R7 Manager 00EO0706530F [7.0{5])] [Administrator (Administrator)]

File Edit ‘Wiew Tools Help
2 -dAEE Al -2
SIP Line - Line 17°

O0EQ0706530F ~ Line

IP Offices

& Bootr(2) [51P Line| Transport [stp URI|vole | T38 Fax| I Credentials|
17 Operator (3)
%% D0EDO706530F ITSP Proxy Address |04 XHR.9 |
2y System (1)
=T Line (3) Metwark Configuration

1
- Laver 4 Protocal Dp v Send Part |5060

e 17 Use Metwork Topology Info  |LAN 2 hd| |

<2 Control Unit (4)
Ay Extension (35)
ﬁ User (32)
@ Hunka@roup (13 Calls Route via Reqistrar
B2 short Code {60}
@ Service (0}
il RAS (L) Separate Registrar |
@ Incoming Call Route {2)
&ﬂ WanPort (0}
g Directory {0)
{l‘\ Time Profile (00
@ Firewall Profile {13
IP Route (4)
g Account Code {0)
8. Licence (76)
% Tunnel {0)
§ User Rights (8
F BRS (1)
' RAS Location Request {0)
fx E911 System (1)

4

Explicit DNS Server(s) | 0O 0 0 o |lo 0 o o |

N e
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Select the SIP URI tab. A SIP URI entry must be created to match each incoming number that
Avaya IP Office will accept on this line. Under the SIP URI tab, click the Add button and the
New Channel area will appear at the bottom of the pane. To edit an existing entry, click an entry
in the list at the top, and click the Edit button. For the compliance test, a single SIP URI entry
was created that matched any DID number assigned to an Avaya IP Office user. The entry was
created with the following parameters:

e Set Local URI, Contact and Display Name to Internal Data. This setting allows
calls on this line with SIP URI matching the number set in the SIP tab of any User as
shown in Section 5.6.

e Set PAI to None. The PAI parameter was introduced in [P Office Release 6.1, and
the value “None” is shown selected from the drop-down menu. With PAI set to
“None”, IP Office Release 6.1 and 7.0 will behave like IP Office Release 6.0 with
respect to the SIP P-Asserted-Identity header (e.g., IP Office will not include a PAI
header for an outbound call unless privacy is asserted).

e Registration parameter is set to the default 0: <None> since Alestra’s Enlace [P SIP
Trunk service does not require registration.

e Associate this line with an incoming line group in the Incoming Group field. This
line group number will be used in defining incoming call routes for this line.
Similarly, associate the line to an outgoing line group using the Qutgoing Group
field. For the compliance test, a new incoming and outgoing group 17 was defined.

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed
using this SIP URI pattern.
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File  Edit  ‘iew  Tools  Help
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2
y, 17
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Ay Extension {34)
i User (32)
u HuntGroup {13
BX short Code (63)
@ Service (1)
S RAS (1)
@ Incoming Call Route (2)
Eﬂ witanPort {0} Edit Channel
s Directory (00

£7) Time Profile (@) Wia 12.34.67.190
{f Firewall Profile (1) Local URI \Use: Internal Data v |
EB IF Route (4)

am Account Code (0) Contack |Use Internal Data " |
-
; ?:i:;a(gs) Display Name |Use Internal Data v|
§a User Rights (g) PAI hone |
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& FLAS Location Fequest {0} Registration |D: <honex w
fix E911 System (1)

Incaming Group 17
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o 3
w
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{

Select the VoIP tab to set the Voice over Internet Protocol parameters of the SIP line. Set the
parameters as follows:

e The Compression Mode was configured using the Advanced button, allowing an
explicit ordered list of codec’s to be specified. Place check marks next to G.729 (a)
8K CS-ACELP and G.711 ALAW 64K which are the codec’s supported by the
Alestra’s Enlace IP SIP Trunk service, in that specific order.

e VolIP Silence Suppression: Set to off (un-checked), default value. When selected,
this option will detect periods of silence on any call over the line and will not send
any data during those silent periods. This feature is not used on IP lines using G711
between systems.

e The Re-invite Supported parameter should be checked to allow for codec re-
negotiation in cases where the target of an incoming call or transfer does not support
the codec originally negotiated on the trunk. The Re-invite Supported parameter
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must also be checked to allow the Fax Transport Support parameter to take on
values other than “none”, or to check the Codec Lockdown parameter.

e Use Offerer’s Preferred Codec: Set to off (un-checked), default value. Normally
for SIP calls the initiator of the calls sends a SIP SDP offer which includes the
supported codec’s in order of preference. The SIP response includes the codec the
callee wants to use for the call. This option can be used to override that behavior and
use the codec preference offered by the caller.

e Select T.38 for Fax Transport Support. Alestra supports T.38 faxing.

e Setthe DTMF Support field to RFC2833. This directs Avaya [P Office to send
DTMF tones using RTP events messages as defined in RFC2833.

e Default values may be used for all other parameters.

File  Edit Wiew Tools Help
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Select the T38 tab. The setting on this tab are only accessible if Re-invite Supported and Fax
Transport Support are selected on the VoIP tab. Use Default Value should be checked
(default). If selected, all the fields are set to their default values and will be displayed as grayed
out.

] Avaya IP Office R7 Manager O0EOQ706530F [7.0(5]] [Administrator{Administrator)]

File  Edit Wiew Tools Help
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5.5 Extension
In this section, examples of IP Office Extensions will be illustrated. In the interests of brevity,
not all users and extensions shown in Figure 1 will be presented, since the configuration can be

easily extrapolated to other users. To add an Extension, right click on Extension then select New
- Select H323 or SIP.

Select the Extn tab. Following is an example of extension 3042; this extension corresponds to an
H.323 extension.

—

| Avaya IP Office R7 Manager 00E00706530F [7.0(5

Edit  Wiew Tools  Help

Administrator{Administrator

File:

[R5 -WEEELAI 28
E H323 Extension: 8006 3042

Extn |vorp |

OO0EQO70&530F = Extension T G006 3042 -
IP Offices

4 Line (3)

<= Contral Unit (43

=4y Extension {35) Extension Id |8006 |
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"W, 5003 3041
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A& 102 3044 Reset Yolume After Calls O
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& 258 9004 Part D
O
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"Wy, 5001 4026

;‘ 8208 4027
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Select the VOIP tab. Use default values on VoIP tab. Following is an example for Extension

3042; this extension corresponds to an H.323 extension.

Fle  Edit  ‘iew  Tools

IP Offices

R BOOTP (2}
i Operator (3)
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3 System (1)
4 Line (3)
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(=4 Extension (35)
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5.6 User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP
line defined in Section 5.4. To configure these settings, first expand User in the left Navigation
Pane, then select the name of the user to be modified. In the example below, the name of the user
is “Ext3042 H323”, an Avaya 9620 IP Telephone (H.323).

File  Edit View Tools Help
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4019 Exkn4019 Quk of hours User Rights
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Y e W
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In the example below, the name of the user is “Ext3047 SIP”. This is an IP Office SIP Softphone
user, set the Profile to Teleworker User and check Enable Softphone.

[l Avaya IP Office R7 Manager 00E00706530F [7.0(5)] [Administrator (Administrator)]

File  Edit Wiew Tools Help
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Select the SIP tab. The values entered for the SIP Name and Contact fields are used as the user
part of the SIP URI in the “From” header for outgoing SIP trunk calls. They also allow matching
of'the SIP URI for incoming calls without having to enter this number as an explicit SIP URI for
the SIP line (Section 5.4). The example below shows the settings for user Ext3042 H323. The
SIP Name and Contact are set to one of the DID numbers assigned to the enterprise. Note that
only 4 digits of the DID number were assigned; this is because in this sample configuration
Alestra’s network was configured to send only 4 digits to the enterprise. The SIP Display Name
(Alias) parameter can optionally be configured with a descriptive name. If all calls involving this
user and a SIP Line should be considered private, then the Anonymous box may be checked to
withhold the user’s information from the network.

il 0 er 00E00706
File — Edit  View Took — Help
i D0E0070ES30F = User - 3042 Ext3042 H3Z3 A= & EE AN =28
IP Offices B Ext3042 H323: 3042 & - X[ v |
(=% DOE00706530F # 1| Farwarding | Dial In | ¥oice Recording | Button Programming | Menu Programming | Mobility | Phone Manager Options | Hunt Group Membership Annuuncament5| SIP
=) System (1)
T4 Line (3) SIP Name |3042 |
<= Control Unit (4)
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3040 Ext3040 H323 [ Anorymous
3041 Ext3041 H323
3042 Ext3042 H323
e 3047 Ext3047 SIP
e 3048 Ext3048 H323
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3043 Extn3043
3044 Extn3044
3049 Extn3049
4002 Extn4002
4003 Extn4003
4004 Extn4004
4005 Extn400S
4008 Extn400&
4007 Extn4007
4008 Extn4003
4011 Extn4011
4012 Extnd4012
4013 Extn4013 B
4014 Extnd4014
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4019 Extn4019
4020 Extnd020
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Select the Voice Mail tab. The following screen shows the Voicemail tab for the user with
extension 3042. The Voicemail On box is checked. Voicemail password can be configured using
the Voicemail Code and Confirm Voicemail Code parameters. In the verification of these
Application Notes, incoming calls from Alestra’s SIP Trunk to this user were redirected to
Voicemail Pro after no answer. Voicemail messages were recorded and retrieved successfully.

Voice mail navigation and retrieval were performed locally and from PSTN telephones to test
DTMF using RFC 2833.

File Edit ‘View Tools Help
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Select the Telephony tab, then Call Settings tab as shown below. Check the Call Waiting On
box to allow an IP Office phone logged in as this extension to have multiple call appearances.
Note: Call Waiting On is also necessary for call transfer.

Fle Edit “iew Tools Help

O0EOO7O0ES30F T User T 3042 Ext3042 H3Z3

IP Offices

(5-*=p O0E00706530F ) | User ” Vaicemail " DD || ShortCodes " Source Mumbers | Telephony |Forwarding " Dial In " Yoice Recording || Button Programming || Menu Programming ” Mobili

“p System (1)
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A Extension (35) Outside Call Sequence |DeFauIt Ring w ‘ Call Waiting On
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‘ Mollser
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3040 ExE3040 H323
3041 Exk3041 H323 Mo Answer Time (secs) |15
3042 Exk3042 H323
3047 Exk3047 SIP
3048 Ext3048 H323 Transfer Return Time {secs) |OFF =
4026 Exk4026 SIP
B4 Exbri3043 Call Cost Mark-Up [100
3044 Extn3044
3049 Extn3049
4002 Extn4002
4003 Extn4003
4004 Extrn4004
4005 Extn4005
4008 Extrn400&
4007 Extn4007
4008 Extn4003
4011 Exkn4011
4012 Extn4012
4013 Extn4013
4014 Extn4014
4015 Extn4015
4016 Extnd016
4017 Extnd017
4018 Extn4018

4019 ixtn40 19

Inside Call Sequence |DeFauIt Ring w ‘ Answer Call Waiing On Hold

[] offhook Station

|
‘Wrap-up Time (secs) |2 e |
|
|
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Select the Mobility tab. In the sample configuration user 3042 was one of the users configured to
test the Mobile Twinning feature. The following screen shows the Mobility tab for User 3042.
The Mobility Features and Mobile Twinning boxes are checked. The Twinned Mobile
Number field is configured with the number to dial to reach the twinned telephone, in this case
912343093. Other options can be set according to customer requirements.

File  Edit  VWiew Tools  Help

i DOEOO70ES30F * User * 3042 ExE3042 H323 2 L E-HIE = A 2.
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3043 Extn3043
Z044 Exbna0dd Twinning Time Profile | <MNone

3049 Extn3043 Mobile Dial Delay {secs) |2 |
4002 Extn4002

4003 Extn4003 Mobile Answer Guard {secs)

4004 Extrn4004

] Hurtt group calls eligible For mobile twinning

4005 Extn4005

4006 Extrnd4006 [] Forwarded calls eligible for mobile twinning
4007 Extn4007 B X

4008 Extn4008 [] Twin Wwhen Logged Out

4011 Extnd011 [ one-x Maobile Clisnt

#012 Extnd012 [ Mabile Call Control

4013 Extnd013

4014 Extn4014 Mobile Callback

4015 Extn4015

4016 Extn4016
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To program a key on the telephone to turn Mobil Twinning on and off, select the Botton
Programming tab on the user, then select the botton to program to turn Mobil Twinning on and
off, click on Edit » Emulation 2 Twinning. In the sample below botton 4 was programmed to
turn Mobil Twinning on and off on user 3041.

File  Edit “ew Tools Help

i DDEDOFOESIOF = User

+ 3041 Exta041 H3za HE. Q5= ,ilﬂﬂ Alv 528

IP Offices

(=57 DOEDO7OES30F

#y Syskem (1)

9 Line (3)

< Control Unit {4}

Ay Extension (35)

E-f User (32)

‘ Hollser
‘ RemoteManager

3040 Ext3040 H323
3041 Ext3041 H323
3042 Ext3042 H323
3047 Ext3047 SIP
3043 Ext3048 H323
4026 Ext4026 SIP
3043 Extn3043
3044 Extn3044
3049 Extn3049
4002 Extn4002
4003 Extn4003
4004 Extn4004
4005 Extn4005
4006 Extn4006
4007 Extn4007
4003 Extn4005
4011 Extn4011
4012 Extn4012
4013 Extn4013
4014 Extn4014
4015 Extn4015
4016 Extn4016
4017 Extn4017
4013 Extn4015

1171

Ext3041 H323: 3041 \ Xl wl<l

L] | User ” Yaicemail ” DHD " ShortCodes ” Source Mumbers " Telephony " Forwarding " Dial In ” Voice Recording | Button Programming | Menu Pragrarming ” Mobility ” Phane Mar

HG:; Reviewed:
SPOC 8/24/2011

4019 Extn4019 P

Button ... | Label Action Action Daka Remove
1 Appearance a=
2 Appearance b= Edit..
3 Appearance = Copy
4 Twinning
5 Bridged Appearance Ext3040 H323;1 Paste
]
7
8
9
10
11
1z

[ isplay all butta

Edit Button

Button No. |6 |

Label | |

Action |Dial | [z]
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5.7 Short Code

Define a Short Code to route outbound traffic to the SIP line. To create a Short Code, select Short
Code in the left Navigation Pane, then right-click and select New. On the Short Code tab in the
Details Pane, configure the parameters for the new Short Code to be created as follows.
¢ Inthe Code field, enter the dial string which will trigger this Short Code, followed by a
semi-colon. In this case, 9N; this Short Code will be invoked when the user dials 9
followed by any number.

e Set Feature to Dial. This is the action that the Short Code will perform.
e Set Telephone Number to N”@xxx.xxx.xxx.9”. This field is used to construct the
Request URI and “To” headers in the outgoing SIP INVITE message. The value N

represents the number dialed by the user. The IP address of the Alestra SIP proxy server
follows the @ sign in the above expression.

e Set the Line Group Id to the outgoing line group number defined on the SIP URI tab on
the SIP Line in Section 5.4. This Short Code will use this line group when placing the
outbound call

e Default values may be used for all other parameters.

File  Edit  View  Tools  Help

O0ECOY06530F * Short Code T 9N =

IP Offices X

B FI2FNE # | short Code |

E_/‘_L_; z3|3;3_ﬂ|v’

X FIFHNR
B3 =34H; Code e |
B RIS :
o *35 Feature |D|a| w |
X FITHNR
B *F3arNE
X *39 Line Group Id |1F" “ |
@ *40
P *41 Locale |Mexic0 {Latin Spanish) w |

Telephone Mumber |N"@xxx.xxx.xxx.9" |

L Force Account Code [ ]
X *43

o *a4q

X F45HhR
X *45
X *47
X *45

The simple “9N;” Short Code illustrated above, although effectively routes the outbound calls to
the SIP trunk, does not provide the means of alternate routing if the configured SIP Line is out of
service or temporarily unavailable, or other features like Secondary Dial Tone. When alternate
routing options and/or more customized features and analysis of the digits following the Short
Code are desired, the Automatic Route Selection (ARS) feature may be used. ARS was
implemented and tested during the compliance tests, but its configuration is beyond the scope of
these Application Notes.
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The following example shows Short Code 2N; This Short Code allows the user to dial any
number starting with the digit “2” without having to dial “9” first.

I~ Avaya IP Office R7 Manager 00EQO0706530F [7.0(5])] [Administrator {Administrator]]

File  Edit  Wiew Tools Help

i DDENO7O0S530F 7 Short Code

IP Offices H

N *44 # ||| Shart Code |
I AT
M 46 Code |2Ni |

“ #47
B *48 Feature |Dia| v |

:: *49 Telephone Mumber |2N @0, 50 e, D |
S0

B 5] Lirne =raup Id |1? ' |
g *E52

B S Locals |
e LT L Force Account Code [
P T
R
P FI000%
- O
- 2,
g *0g
B *DS5N
G +SDN
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5.8 Incoming Call Route

Incoming Call Routes map inbound DID numbers on a specific line to internal extensions, hunt
groups, Short Codes, voicemail, etc. in the IP Office. Incoming Call Routes should be defined for
each DID number assigned by the service provider, matching incoming numbers on the SIP line
with defined destinations in IP Office.

In a scenario like the one used for the compliance test, only one incoming route is needed, which
allows any incoming number arriving on the SIP trunk to reach any extension in IP Office, and
effectively performing all routing decision for the call based on the parameters already
configured for Call Routing Method, set to To Header (Section 5.4), and each user’s SIP
Name and Contact fields, already populated with the assigned DID numbers provided by
Alestra (Section 5.6).

From the left Navigation Pane, right-click on Incoming Call Route and select New.

On the Details Pane, under the Standard tab, set the parameters as show bellow:
e Sect Bearer Capacity to Any Voice.
e Set the Line Group Id to the incoming line group of the SIP line defined in Section 5.4.
e Default values may be used for all other parameters.

File  Edit  ‘iew  Tools  Help

i OOEDOTOBS30F = Incoming Call Routs - 17 - |}

IP Offices H

K B0OTP(2) Skandard
i Operator (3)
%3 DOEOO7O6530F Bearer Capability |P.ny Woice b |

a9 Syskem (1)

‘oice Recording | Destinations

- Line Group Id 17 W
17 Line (3} R | |
“= Control Unit (4) Incoming Mumber | |
Ay Extension (35)

§ user(z Incoring Sub Address | |

ﬁ HuntGroup {13

I ing CLI
BX short Code (63) rieeming | |

@ Service {0) Locale | v|
ol RAS (1)
=4 Incoming Call Raute (2) Priority | 1 - Low - |
TN
@ 0 Tag | |
€@ wanPort (0) Hold Music Source |System Source - |

s Directory (00

f:.“ Time Profile (0}
@ Firewall Profile {13
EB IF Route (4)

i Account Code (0)
& Licence (76)

HG; Reviewed: Solution & Interoperability Test Lab Application Notes 33 of 43
SPOC 8/24/2011 ©2011 Avaya Inc. All Rights Reserved. AlestraSIPIPOR7



Under the Destinations tab, enter “.” for Destination. This will enable all incoming calls to
be routed to any extension.

] Avaya IP Office RY Manager O0EO0706530F [7.0(5)] [Administrator(fdministrator)]

Edit  VYiew Tools Help

O0EOO706S30F 7 Incoming Call Route Y A
IP Offices

& BOOTR(2)
{7 Operator (3)

[=-#%p DOENO70ES30F TimeProfile Destination Fallback Extension
57 System (1) » Default Yalue . 3
T4 Line (3}
<= Conkrol Unit {4}
A% Extension (35)
a User (32}
%8 HuntGroup (1)
B short Code (63)
B Service (0)
o RAS (1)

[25-HIEEBE A s 2%

| Standard " Voice Recording | Destinations

(=4 Incoming Call Routs (2)
@17
@0
@ wanPart {0}
s Directary (0)
f:ﬂ Tirme Profile {0)
) Firewall Prafile (1)
IP Route (4)
| Account Code (0)
B Licence (76)
W Tunnel (0}
a‘i User Rights {8}
g ARS (1)
" RAS Location Request (0)
fix E911 System (1)

e A sube ant o
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5.9 Privacy/Anonymous Calls

For outbound calls with privacy (anonymous) enabled, Avaya IP Office will replace the calling
party number in the From and Contact headers of the SIP INVITE message with “restricted” and
“anonymous” respectively. Avaya IP Office can be configured to use the P-Preferred-Identity
(PPI) or P-Asserted-Identity (PAI) header to pass the actual calling party information for
authentication and billing. By default, Avaya IP Office will use PPI for privacy. For the
compliance test, PAI was used for the purposes of privacy.

To configure Avaya IP Office to use PAI for privacy calls, navigate to User = NoUser in the
Navigation Pane. Select the Source Numbers tab in the Details Pane. Click the Add button.

File  Edit Miew Tools Help

2 5-dEEE A28
ﬁ NoUser: * B - X[ v ]=|

OOENOFO6530F T User = Nolser -4

IP Offices

T4 Line (3) AN | User || voicemail | OND || ShartCades | Source Numbers |Te\ephony Forwarding | Dial In | Yoice Recording | Butkon Programming || Menu Programming || 4
<2 Conkrol Unit: {4}
A Extension (35) Source Number
= a User {32}
S Molser Remave
; RemoteManager
3040 Exk3040 H32: Edit...

3041 Ext3041 H320
3042 Ext3042 H32:
e 3047 Ext3047 SIP
o 5048 Ext3048 H3Z!
e 4026 Ext4026 SIP
3043 Extn3043
3044 Extn3044
3049 Extn3049
400E Extnd00Z
4003 Extn4003
4004 Extnd004
4005 Extn4005
4006 Extnd006
4007 Extn4007
400& Extnd005
4011 Extrn4011
4012 Extnd0lZ
4013 Extn4013
4014 Extnd014
4015 Extn4015
4016 Extnd016
4017 Extn4017
4018 Extnd018
4019 Extn4019
4020 Extn4020

T R P gt o e gt g0 gt P patmnd™ o ool

At the bottom of the Details Pane, the Source Number field will appear. Enter
SIP_USE_PAI FOR _PRIVACY. Click OK.

Edit Source Number
’V Source Mumber SIP_LISE_PAI_FOR_PRIVACY
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The SIP_USE_PAI_FOR_PRIVACY parameter will appear in the list of Source Numbers as
shown below.

4 Avaya IP Office R7 Manager OOEO0706530F [7.0(5])] [Administrator{Administrator)]
File  Edit %iew Tools Help

OOEDO7OES30F - [User

IP Offices

¥-17 Line (3) ~
» Conkrol Unit (4)

-y Extension (35) Source Murmber

=-f  User (32) SIP_UUSE_PAI_FOR_PRIVACY
‘ Maollser

- §rg RemateManager
~§ 3040 Ext3040 HaZ: Ed..
@ 3041 Ext3041 H32:
@ 3042 Ext3042 H3Z:
i 3047 Ext3047 SIP
@i 3048 Ext3048 H3Z:
e 4026 Ext4026 SIP
@ 3043 Extn3n43
@ 3044 Extn3ne4

- | Mollser

| User ” Yaicemail || DND || shortCodes | Source Mumbers |Teleph0ny || Forwarding || Dial In || Yoice Recording || Button Programming ” Menu Programming ||- 4

Remaove
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5.10 SIP Options Frequency

Avaya IP Office sends SIP OPTIONS messages periodically to determine if the SIP connection
is active. The rate at which the messages are sent is determined by the combination of the
Binding Refresh Time (in seconds) set on the Network Topology tab in Section 5.1 and the
SIP_OPTIONS_PERIOD parameter (in minutes) that can be set on the Source Number tab of
the NoUser user. The OPTIONS period is determined in the following manner:

e Ifno SIP_OPTIONS_PERIOD parameter is defined and the Binding Refresh Time is
0, then the default value of 44 seconds is used.

e To establish a period less than 42 seconds, do not define a SIP_OPTIONS_PERIOD
parameter and set the Binding Refresh Time to a value less than 42 secs. The OPTIONS
message period will be equal to the Binding Refresh Time.

e To establish a period greater than 42 seconds, a SIP_OPTIONS_PERIOD parameter
must be defined. The Binding Refresh Time must be set to a value greater than 42 secs.
The OPTIONS message period will be the smaller of the Binding Refresh Time and the
SIP_OPTIONS_PERIOD.

To configure the SIP_OPTIONS_PERIOD parameter, navigate to User = NoUser in the
Navigation Pane. Select the Source Numbers tab in the Details Pane. Click the Add button.

- LI
File Edit view Tools Help
} noE0070RS30F + [User «| Holser HEEE LA v 28

IP Offices E NoUser:

®- T Line (3) ~
#-+<2 Contral Uit (4)
# 4 Extension (35) Source Mumber m
=-§ User(32) SIP_UUSE_PAI_FOR_PRIVACY
; Maollser Remove
S RemateManager
3040 Ext3040 H32: Ed..
3041 Ext3041 H32!
3042 Ext3042 H32!
e 3047 Ext3047 SIP
e 3048 Ext3048 H32!
e 4026 Ext4026 SIP
3043 Extn3043

3044 Extn3044
3049 Extn3049
4002 Extn4002
4003 Extn4003
e WM W el

At the bottom of the Details Pane, the Source Number field will appear. Enter
SIP_OPTIONS_PERIOD=X, where X is the desired value in minutes. Click OK.

ef - X v | <

Uset | Yoicemail | DMD | ShortCodes | Source Mumbers | Telephony | Forwarding | Dial In || Yoice Recording | Button Programming | Menu Programming | 4

Edit Source Mumber

Source Mumber SIP_OPTIONS_PERIOD=3
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For the compliance test, an OPTIONS period of 5 minutes was desired. The Binding
Refresh Time was set to 300 seconds (5 minutes) in Section 5.1; the
SIP_OPTIONS_PERIOD was set to 8 minutes. Avaya IP Office chose the Binding
Refresh Time of 300 seconds (5 Minutes) as the smaller of these two values.

File  Edit Wew Tools Help

ODEOO7O6S30F - |User - | MaUser = i
E NoUser: = YA

IP Offices
T Line (3) L | User ” Yaicemail " DHD " shortCodes | Source Numbers |Te|ephony ” Forwarding ” Dial In ” Vaice Recording " Button Programming " Menu Pragramming " <
< Control Unit {4)
Ay Extension (35) Source humber
@ User(32) SIP_LISE_PAT_FOR_PRIVACY
frg MoUser SIP_OPTIONS_PERIOD=5 Remove

: RemateManager

a 3040 Ext3040 H3Z!
a 3041 Ext3041 H3Z!
a 304Z Ext3042 H3Z!
arv 3047 Ext3047 SIP
arv 3043 Ext3048 H3Z!
arv 4026 Ext4026 SIP
§ 3043 Extn3ne3

E 3044 ExtHSD‘HI ' ~

Edit...
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5.11 Save Configuration

When desired, send the configuration changes made in IP Office Manager to the IP Office server
to cause the changes to take effect.

Navigate to File > Save Configuration in the menu bar at the top left of the screen to save the
configuration performed in the preceding sections.

Once the configuration is validated, a screen similar to the following will appear, with either the
Merge or the Immediate radio button chosen based on the nature of the configuration changes

made since the last save. Note that clicking OK may cause a service disruption due to system
reboot. Click OK if desire.

IP Office Sektings

QO0EQO0&530F

Configuration Rebook Mode
@ Merge

() Immediate

() when Free

) Timed

Reboat Time

EEXCRNEY

Call Barring

[ K, H Cancel H Help ]
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6. Verification Steps

The following steps may be used to verify the configuration:

e Use the Avaya IP Office System Status application to verify the state of the SIP
connection. Launch the application from Start > Programs - IP Office
- System Status on the PC where Avaya IP Office Manager was installed. Log in
using the appropriate credentials, and select the SIP line of interest from the left pane. On
the Status tab in the right pane, verify that the Current State is Idle for each channel
(assuming no active calls at present time).

IP Office R7 System Status - O0E00706530F (172.16.5.60) - IP500 ¥2 7.0 (9)

AVAYA IP Office System Status

Help  Snapsh Exit About

Alarmns

SIP Trunk Summary

Peer Domain Mame: #

Resolved Address: "

Lire Murnber: 17

Number of Administered Channels: 10

Mumber of Channels in Use: 0

Administered Compression: G714

Slence Suppression: OFf

SIP Trurk Channed Licences: Unllirnited . 0

SIP Trunk Channel Licences in Use: ]

SIP Device Features: REFER {jincoming and outgaing)

Channel Current

Murnber Skate
1 Idle
H Idle: kY
3 Idle )
4 Ide
5 1de )
& Idle
7 Ide Y
[ Idle
El Ide
10 Idle
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e Select the Alarms tab and verify that no alarms are active on the SIP line.

HE IP Office a O0EQO 706530 6.5.60) - IP500 \

AVAyA IP Office System Status

Status  Ukilization Summary: Alarms

|+ N+

Alarms for Line: 17 SIP I:

Line: 17

e Verify that a phone connected to Avaya IP Office can successfully place calls to the
PSTN with two-way audio.

e Verify that a phone connected to PSTN can successfully place calls to Avaya IP Office
with two-way audio.

7. Conclusion

Alestra’s Enlace IP SIP Trunk Service passed compliance testing. These Application Notes
describe the procedures required to configure the SIP trunk connectivity between Avaya IP
Office and Alestra’s Enlace IP SIP Trunk Service, as shown in Figure 1
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Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya
DevConnect Program at devconnect@avaya.com.
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